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Lightroom Classic — Analog Film Workflow Cookbook
A practical reference for the complete analog photography workflow: scanning, importing, 
converting, editing, labeling, exporting, and metadata management. All steps reference the 
confirmed Mac + Synology NAS architecture.

Environment: MacBook Air M5 / Lightroom Classic / Negative Lab Pro / Epson V800 / 
Synology NAS via Synology Drive



Lightroom analog film workflow: scan → label → export to multiple destinations



1. Scanning a New Roll

Setup
1. Mount film in Lomography 120 Film Mask (medium format) or 35mm holder
2. Open Epson Scan 2 on Mac

B&W scanning (saved preset: "Negative Scan B&W")
Setting Value

Mode Photo Mode

Document Type B&W Negative Film

Image Type 16-bit Grayscale

Resolution 6400 DPI

Scanning Quality High

Image Format TIFF

Color scanning
Setting Value

Mode Photo Mode

Document Type Color Negative Film

Resolution 4800 DPI

Scanning Quality High

Image Format TIFF

Advanced Settings — all OFF: Unsharp Mask, Color Restoration, Backlight Correction, Dust 
Removal, Grain Reduction, DIGITAL ICE Technology. NLP handles all corrections downstream 
— scanner corrections interfere with accurate NLP conversion.

File naming and saving
3. File Name: Pentacon Six TL R## ### (camera + roll + frame)
4. Folder: R##-LabNr (e.g., R44-9446)
5. Save TIFFs to: ~/Pictures/Local-RAW-Files/[Camera]/[Roll#-LabNr]/

Example: ~/Pictures/Local-RAW-Files/Pentacon Six TL/R44-9446/
6. Synology Drive syncs to NAS /Photography/RAW Files/ automatically in the 

background

Roll folder naming: R##-LabNr format (e.g., R37-0000). Roll number first — that's how you 
think and reference. Lab number preserved for cross-reference with the physical negative 
binder. Rename legacy lab-number-only folders gradually through Lightroom (right-click → 
Rename), not in bulk.

2. Importing into Lightroom
1. File → Import Photos and Video



2. Source: navigate to ~/Pictures/Local-RAW-Files/[Camera]/[Roll#-LabNr]/
3. Import type: Add (files are already in the right location — don't move or copy)
4. Right panel — Apply During Import:

— Develop Settings: None
— Metadata: select the appropriate NLP camera preset (see Section 8)
— Keywords: add roll-specific keywords if desired

5. Click Import

No auto-adjustments on import. NLP needs the unmodified scan data for accurate 
conversion. Don't apply develop presets during import.

3. Negative Lab Pro Conversion
1. Select all images from the roll in Library or Develop module
2. Open NLP: File → Plug-in Extras → Negative Lab Pro
3. Set source: match your film type

— B&W Negative for Ilford XP2 Super 400, FP4 Plus 125
— Color Negative for Kodak Gold 200

4. Convert — NLP processes all selected images
5. Fine-tune individual images in NLP's editing panel if needed
6. Apply changes

After NLP conversion: The images are now positive. From this point, Lightroom's standard 
Develop module tools work normally — exposure, contrast, cropping, B&W treatment, etc.

4. Editing Workflow

First pass — cull and label
1. Switch to Library module → Loupe view (E key) or Survey view (N key)
2. Go through each frame. Apply color labels:

Label Meaning Keyboard shortcut

Red Original negative — no 
export, reference only

6

Yellow Correction needed — 
revisit later

7

Green Good to use — candidate 
for sharing or projects

8

Blue Portfolio — your best 
work

9

 
Purple (To Print) is applied later — requires creating a virtual copy, soft-proofing 
against SAAL's ICC profile for silk paper, and adjusting develop settings for print output.



3. Flag obvious rejects (X key) — don't delete yet, just flag

Second pass — develop
4. Switch to Develop module (D key)
5. Work through Green and Blue labeled images:

— Crop and straighten
— Exposure and contrast refinement
— Local adjustments (masks, gradients) if needed
— Sharpening: respect film grain — it's a feature, not a flaw
— Dust spot removal: these are scanner artifacts, worth fixing

Grain vs dust: Grain and motion softness = authentic film characteristics, leave them. Dust 
spots = scanner artifacts, clean them up. Sharpness from difficult conditions = earned. Focus 
error = consider swapping frames if an alternative exists.

B&W conversions from color originals
6. If a color image works better in B&W (e.g., Sedona Kodak Gold CPL recovery shots):

— Right-click → Create Virtual Copy
— Apply B&W treatment on the virtual copy
— The original keeps the color correction
— Label the virtual copy independently (Blue if portfolio-worthy)

Naming
7. Select the image in Library module
8. Metadata panel → Title field: enter the published title

Format: Title R##|###
Example: Clouds over Deep Time R35|013

9. To rename the file: Library → Rename Photo (F2)
Use Lightroom's file rename template to match the title format
Example filename: Clouds over Deep Time R35-013.jpg

5. Color Label Workflow

Custom Color Label Set (must be configured on Mac):
Metadata → Color Label Set → Edit...

Red: Original Negative
Yellow: Correction Needed
Green: Good to Use
Blue: Portfolio
Purple: To Print

This custom set must match between machines. If labels show as grey, the set doesn't match.

Key principle: Labels are STATUS, not routing.
An image labeled Blue (portfolio) can be exported to Portfolio/, Photos/, Projects/, and Flickr. 



Blue is the highest quality tier for screen/web use. Purple is specifically for print — a virtual 
copy of a Blue image, soft-proofed against SAAL Digital's ICC profile for silk paper, with develop 
settings adjusted for physical output.

Label hierarchy
Label Status Can export to

Red Reference only — no 
export

—

Yellow Needs work — fix, then 
relabel

—

Green Good to use Photos/ (family 
sharing), Blog/

Blue Portfolio — best work 
(screen/web optimized)

Portfolio/, SAAL Print/ 
(when no proof 
adjustment needed), 
Photos/, Projects/, 
Blog/, Flickr

Purple Print-ready — virtual 
copy with proof-
adjusted develop 
settings for SAAL silk 
paper + ICC profile

SAAL Print/ (only when 
proof adjustment is 
needed)

Label lifecycle
Stage Action

Import All images start unlabeled

First cull Apply Red (reference only), Yellow 
(needs work), Green (good)

After editing Yellow → Green or Blue once 
corrected. Don't leave images yellow 
permanently.

Portfolio curation Promote Green → Blue for your best 
work

Print selection If image needs proof adjustment for 
silk paper: create virtual copy → soft-
proof against SAAL ICC → adjust 
develop settings → label Purple. If 
image prints fine as-is: export directly 
from Blue original.

Tracking prints with keywords

Use keywords to track print history:



Keyword When to apply

Printed After ordering from SAAL Digital

Create two smart collections for workflow management:

Smart Collection Rules

Portfolio Collection not Printed See nested rule structure below

Printed Keywords contains "printed"

Smart collection nested rules (using the # button):
Lightroom smart collections support nested rule groups via the # button. Click # to create a 
subset of rules with its own logic (All/Any/None of the following). This lets you combine 
AND/OR logic:

Portfolio Collection not Printed:
Match: any of the following rules:
    ├── All of the following are true:
  │     Keywords └── doesn't contain "printed"
    ├── Any of the following are true:
  │     Label Color ├── is blue
  │     Label Color └── is purple

This catches all Blue and Purple images that haven't been printed yet — your entire best-work 
pool.

How these work together: "Portfolio Collection not Printed" shows both Blue originals and 
Purple virtual copies that haven't been printed yet. After ordering a print, add keyword 
Printed to whichever version was printed (Blue or Purple). It drops out of the first collection 
and appears in the second.

Export destinations by purpose

One image can go to multiple destinations. The label tells you what it is; you decide where it 
goes:

Destination (NAS) Purpose Typical label

Photography/
Portfolio/Full/

Full-res portfolio 
archive

Blue

Photography/
Portfolio/
Watermarked/

Flickr, web sharing Blue

Photography/SAAL 
Print/[order 
name]/

Print orders Blue (no adjustment 
needed) or Purple 
virtual copy (proof-
adjusted)

Photos/YYYY-MM-DD Family sharing via Green or Blue



Destination (NAS) Purpose Typical label
Event Name/ Synology Photos
Photography/
Projects/YYYY-MM-
Title/

Zine publications Blue (project-driven 
selection)

Blog/images/ Website blog posts Green or Blue

Example: Your best Arizona shot is Blue. You export it to Portfolio/Full/, 
Portfolio/Watermarked/ (for Flickr), and Photos/2025-10 Arizona/ (for your wife). For a print: 
if it prints fine as-is, export the Blue original to SAAL Print/Grand Canyon/. If it needs 
adjustment for silk paper, create a virtual copy, soft-proof against SAAL's ICC profile, adjust 
develop settings, label it Purple, then export. Either way, add keyword "Printed" after ordering.

6. Exporting

Export presets to create

Preset 1: Portfolio Full-Res
Setting Value

Export Location ~/Pictures/Exports/ (move to 
NAS after)

File Format JPEG

Quality 100

Color Space sRGB

Image Sizing Don't resize

Sharpening Screen, Standard

Watermarking Off

File Naming Custom Name - Original File 
Number or title-based template

Preset 2: Portfolio Watermarked

Same as Preset 1, except:

Setting Value

Watermarking On — select your watermark preset

Creating a watermark preset: Lightroom → Edit → Edit Watermarks. Design your watermark 
(text or graphic), save as a preset. It's then available in any export dialog under the 
Watermarking section.



Preset 3: SAAL Print

Use for both Blue originals (when no proof adjustment needed) and Purple virtual copies 
(when proof-adjusted):

Setting Value

Export Location ~/Pictures/Exports/ (move to 
NAS after)

File Format JPEG

Quality 100

Color Space Match SAAL ICC profile (soft-proof in 
Develop before export)

Image Sizing Don't resize

Sharpening Matte or Glossy, Standard (match 
your paper — silk)

Watermarking Off

Print proofing workflow (only when adjustment needed): Create a virtual copy, label it 
Purple. In Develop module: View → Soft Proofing → select SAAL Digital's ICC profile for silk 
paper. Adjust develop settings while soft-proofing is active. These adjustments stay on the 
virtual copy — the Blue original is untouched. If the image prints fine without adjustment, skip 
this step and export the Blue original directly.

Preset 4: Family/Trip Sharing
Setting Value

Export Location ~/Pictures/Exports/ (move to 
NAS after)

File Format JPEG

Quality 85-95 (balance of quality and file size)

Color Space sRGB

Image Sizing Resize to fit: Long Edge, 3000-4000px 
(sufficient for sharing)

Sharpening Screen, Standard

Watermarking Off

After export: move to NAS

All exports land in ~/Pictures/Exports/ first. Then move to the appropriate NAS 
destination via Finder → Connect to Server (smb://10.0.0.5/home/):

Export type Move to

Portfolio full-res Photography/Portfolio/Full/

Portfolio watermarked Photography/Portfolio/
Watermarked/



Export type Move to

Print (Blue or Purple) Photography/SAAL 
Print/[order topic]/ (e.g., 
Grand Canyon/, Zion/)

Family/trip sharing Photos/YYYY-MM-DD Event 
Name/

Zine project Photography/Projects/YYYY-
MM-Title/

Blog images Blog/images/

Filename convention for all exports: Title R##-###.jpg (e.g., Clouds over Deep 
Time R35-013.jpg). The title is the published name, the R##-### suffix traces back to the 
master TIFF. Consistent across all destinations.

7. Virtual Copies

When to create

Create a virtual copy when you want a genuinely different interpretation of the same master:

• B&W conversion of a color original
• Print preparation (only when needed) — virtual copy of a Blue image, soft-proofed 

against SAAL's ICC profile for silk paper. The Blue original stays screen-optimized, the 
Purple copy carries print-specific develop adjustments. If the image prints fine without 
adjustment, skip the virtual copy and export the Blue original directly.

• Significantly different crop (square vs landscape)
• Different tonal treatment for a specific publication

Right-click the image → Create Virtual Copy. The copy appears with a turned page icon in the 
filmstrip. Both reference the same master TIFF — zero disk space cost.

When to delete

Delete virtual copies that were scratch experiments. If you tested a crop or a preset and it didn't 
work — remove it. Virtual copies are free to create but clutter the catalog if left as orphans.

Labeling

Apply the same color label system to virtual copies. The original and the virtual copy can have 
different labels. If the B&W version is portfolio-worthy, label it Blue. If the color original is just 
a reference, label it Red. They're independent.



8. Negative Lab Pro Metadata Presets

Where to see NLP metadata in Lightroom: Library module → Metadata panel → change the 
dropdown at the top from "Default" to "All Plug-in Metadata". NLP fields are only visible in 
this view.

Presets don't survive Windows → Mac migration. Recreate them on Mac: Metadata panel 
→ Preset dropdown → Edit Presets.

Create one preset per camera+lens combination. Apply per roll after import. Fill in film-specific 
fields per roll.

Pentacon Six TL — Biometar 80
Field Value

Camera Make VEB Pentacon Dresden

Camera Model Pentacon Six TL

Lens Make Carl Zeiss Jena

Lens Model Biometar 80mm f/2.8

Focal Length 80mm

Film Format 6x6

Scan Method Home Scan (or Lab Scan — per roll)

Scan Equipment Epson V800

Film Holder Lomography 120 Film Mask

Pentacon Six TL — Biometar 120
Field Value

Camera Make VEB Pentacon Dresden

Camera Model Pentacon Six TL

Lens Make Carl Zeiss Jena

Lens Model Biometar 120mm f/2.8

Focal Length 120mm

Film Format 6x6

Scan Method Home Scan

Scan Equipment Epson V800

Film Holder Lomography 120 Film Mask

Pentacon Six TL — MIR 38B
Field Value

Camera Make VEB Pentacon Dresden

Camera Model Pentacon Six TL

Lens Make Arsenal



Field Value

Lens Model MIR 38B 65mm f/3.5

Focal Length 65mm

Film Format 6x6

Scan Method Home Scan

Scan Equipment Epson V800

Film Holder Lomography 120 Film Mask

Pentacon Six TL — Biometar 80 + Arsenal 2x Teleconverter
Field Value

Camera Make VEB Pentacon Dresden

Camera Model Pentacon Six TL

Lens Make Carl Zeiss Jena

Lens Model Biometar 80mm f/2.8 + Arsenal 2x TC

Focal Length 160mm

Film Format 6x6

Scan Method Home Scan

Scan Equipment Epson V800

Film Holder Lomography 120 Film Mask

Gear Notes Arsenal 2x teleconverter

Pentacon Six TL — Biometar 120 + Arsenal 2x Teleconverter
Field Value

Camera Make VEB Pentacon Dresden

Camera Model Pentacon Six TL

Lens Make Carl Zeiss Jena

Lens Model Biometar 120mm f/2.8 + Arsenal 2x 
TC

Focal Length 240mm

Film Format 6x6

Scan Method Home Scan

Scan Equipment Epson V800

Film Holder Lomography 120 Film Mask

Gear Notes Arsenal 2x teleconverter

Zeiss Ikon Ikonta 521/2
Field Value

Camera Make Zeiss Ikon

Camera Model Ikonta 521/2



Field Value

Lens Make Carl Zeiss

Lens Model Tessar 10.5cm f/4.5

Focal Length 105mm

Film Format 6x9

Scan Method Home Scan

Scan Equipment Epson V800

Film Holder Lomography 120 Film Mask

Zeiss Ikon Contina IIa
Field Value

Camera Make Zeiss Ikon

Camera Model Contina IIa

Lens Make Zeiss

Lens Model Novar Anastigmat 1:3.5 45mm

Focal Length 45mm

Film Format 35mm

Scan Method Home Scan

Scan Equipment Epson V800

Holga 120 GCFN
Field Value

Camera Make Holga

Camera Model 120 GCFN

Film Format 6x6

Scan Method Home Scan

Scan Equipment Epson V800

Film Holder Lomography 120 Film Mask

Per-roll fields (fill in after applying camera preset)
Field Common values

Film Stock Ilford XP2 Super 400, Ilford 
FP4 Plus 125, Ilford HP5 Plus 
400, Kodak Gold 200

Film ISO 400, 125, 400, 200

Shot at ISO Same as Film ISO (unless 
pushed/pulled)

Scan Equipment Epson V800 (home scans only)

Developed At Lab name or Home



Field Common values

Developer Developer chemistry if known

9. Roll Folder Structure

Each roll folder under a camera contains masters and the contact sheet. No export subfolders.

Pentacon Six TL/
├── R37-0000/
│   ├── Pentacon Six R37 001-positive.tif
│   ├── Pentacon Six R37 002-positive.tif
│   ├── ...
│   ├── Pentacon Six R37 013-positive.tif
│   └── R37.pdf                             ← contact sheet
├── R38-0000/
└── ...

What goes where:
In the roll folder: Master TIFFs + contact sheet PDF. That's it.
NOT in the roll folder: JPEG exports. Those go to their destinations (Portfolio/, Projects/, 
SAAL Print/, Photos/).

10. Complete Roll Processing Checklist

End-to-end from receiving scans to final exports:

1. Scan (or receive lab scans)
2. Save TIFFs to ~/Pictures/Local-RAW-Files/[Camera]/R##-LabNr/
3. Save contact sheet PDF alongside the TIFFs as R##.pdf
4. Import into Lightroom (Add, no develop settings, apply NLP camera preset)
5. Apply NLP per-roll metadata: Film Stock, Film ISO, Scan Equipment
6. NLP convert — select all, run Negative Lab Pro
7. First cull — apply color labels (Red/Yellow/Green)
8. Develop — edit Green and Blue candidates
9. Title — add Lightroom titles in Title R##|### format
10. Promote — Green → Blue for portfolio picks
11. Virtual copies — create for B&W conversions or alternative treatments, label 

independently
12. Export — one image, multiple destinations as needed:

— Blue → Portfolio/Full/ + Portfolio/Watermarked/
— Purple virtual copy (proof-adjusted) or Blue original (if no adjustment needed) → 
SAAL Print/[order topic]/
— Green or Blue (trip photos) → Photos/YYYY-MM-DD Event Name/



— Zine curation → Projects/YYYY-MM-Title/
— Blog → Blog/images/

13. Move exports from ~/Pictures/Exports/ to NAS destinations
14. Upload watermarked to Flickr if desired
15. Track prints — add "Printed" keyword to the Purple virtual copy after ordering from 

SAAL
16. Clean up — delete scratch virtual copies, change Yellow → Green/Blue once fixed

Quick Reference: File Paths
What Mac path NAS path

Lightroom catalog ~/Pictures/
Lightroom/Catalog/

Backed up to 
/Photography/Light
room Backup/

RAW Files (masters) ~/Pictures/Local-
RAW-Files/

/Photography/RAW 
Files/

Export staging ~/Pictures/
Exports/

— (local only, temp)

Portfolio — /Photography/
Portfolio/Full/ + 
Watermarked/

SAAL Print — /Photography/SAAL 
Print/[order 
topic]/

Projects (zines) — /Photography/
Projects/

Family sharing — Photos/YYYY-MM-DD 
Event Name/

Blog images — Blog/images/

Quick Reference: Keyboard Shortcuts
Action Shortcut

Library module G (grid) / E (loupe)

Develop module D

Survey view N

Flag as Pick P

Flag as Reject X

Red label 6

Yellow label 7

Green label 8

Blue label 9



Action Shortcut

Purple label No default shortcut — apply via 
right-click or Metadata menu

Remove label Press same number again

Rename photo F2

Create virtual copy ' (Cmd + apostrophe)⌘
Export E (Cmd + Shift + E)⌘⇧

Future Considerations

Legacy scanned slides (~5000 images)

Approximately 5000 color slides from the 1970s onward have been scanned on the Epson V800 
and currently live in Photos/ on the NAS (Synology Photos personal space). These span 
multiple cameras across decades:

• Kodak Instamatic
• Voigtländer (with Color-Skopar f/2.8 lens)
• Praktica MTL3 / Revueflex (rebranded) with f/2.0 multicoated lens
• Pentax MZ 50 (standard zoom ~30-80mm, Tokina ~210mm telephoto, plus the Praktica 

lens)

Decision: Keep legacy slides separate from the analog workflow.
These stay in Photos/ under Synology Photos — not in Photography/. Goal is to correct and 
share via Synology Photos, not to manage them in the Lightroom analog workflow catalog.

Approach: Create a separate Lightroom catalog for legacy slide work. Access slides via SMB 
mount (smb://10.0.0.5/home/Photos/). Import images needing correction into the 
legacy catalog, edit, export corrected versions back to the same Photos/ location. Synology 
Photos picks up changes automatically. No need to manage all 5000 in Lightroom — only the 
ones that need work. Photos stay in their existing YYYY-MM event folder structure.

Keyboard shortcuts shown are Lightroom Classic defaults for macOS. Verify in Lightroom → 
Keyboard Shortcuts if any differ on your installation.

Companion document to the Storage Architecture plan. April 2026.


	Lightroom Classic — Analog Film Workflow Cookbook
	1. Scanning a New Roll
	Setup
	B&W scanning (saved preset: "Negative Scan B&W")
	Color scanning
	File naming and saving

	2. Importing into Lightroom
	3. Negative Lab Pro Conversion
	4. Editing Workflow
	First pass — cull and label
	Second pass — develop
	B&W conversions from color originals
	Naming

	5. Color Label Workflow
	Label hierarchy
	Label lifecycle
	Tracking prints with keywords
	Export destinations by purpose

	6. Exporting
	Export presets to create
	Preset 1: Portfolio Full-Res
	Preset 2: Portfolio Watermarked
	Preset 3: SAAL Print
	Preset 4: Family/Trip Sharing

	After export: move to NAS

	7. Virtual Copies
	When to create
	When to delete
	Labeling

	8. Negative Lab Pro Metadata Presets
	Pentacon Six TL — Biometar 80
	Pentacon Six TL — Biometar 120
	Pentacon Six TL — MIR 38B
	Pentacon Six TL — Biometar 80 + Arsenal 2x Teleconverter
	Pentacon Six TL — Biometar 120 + Arsenal 2x Teleconverter
	Zeiss Ikon Ikonta 521/2
	Zeiss Ikon Contina IIa
	Holga 120 GCFN
	Per-roll fields (fill in after applying camera preset)

	9. Roll Folder Structure
	10. Complete Roll Processing Checklist
	Quick Reference: File Paths
	Quick Reference: Keyboard Shortcuts
	Future Considerations
	Legacy scanned slides (~5000 images)



